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Par la rédaction 
d’iPomme

Apple, une autre transition

Editorial

A quelques semaines de la MacWorld Ex-
po 2009, la nouvelle est tombée comme 
un couperet : Steve Jobs sera absent de la 
keynote inaugurale du 6 janvier. Phil 
Schiller, le «senior vice president of 
Worldwide Product Marketing» d'Apple, se 
chargera de le remplacer. Pire, la firme 
pommée a fait savoir qu'elle ne participe-
rait à aucune édition ultérieure de ce salon 
historique, ce qui n'est pas sans rappeler le 
sort de notre Apple Expo française. Reed, 
la société qui organisait jusqu'ici ce salon 
annuel pour le compte d'Apple, a en effet 
récemment confirmé l'évidence : il n'y au-
ra pas d'édition 2009. L'Apple Expo étant 
avant tout du fait d'Apple, il est logique 
qu'un organisateur tiers ne puisse décider 
seul de sa survie (survie qui aurait été pré-
caire de toute manière, au vu de l'absence 
du principal intéressé). De toute évidence, 
le vent a tourné, et Apple ne s'en cache 
pas : "nous touchons de plus en plus de 
monde avec de plus en plus de moyens, 
les salons sont donc devenus un facteur 
négligeable pour atteindre nos clients. La 
popularité croissante des Apple Stores et 
le site Apple.com nous permettent de 
toucher plus de cent millions de clients 
autour du monde." annonçait la Pomme 
lors d'un communiqué de presse. Pour au-
tant, le glas des keynotes n'a pas encore 
sonné ; au pire, les «special events» en 
comité restreint à Cupertino se feront plus 

nombreux (les MacBook Unibody, entre 
autres, y furent présentés). Et il reste en-
core la Worldwide Developers Conference 
(WWDC) qui se déroule chaque année en 
juin. Ce qui rend la pilule si dure à avaler 
pour les aficionados de la firme, c'est que 
ce choix coïncide avec le retrait progressif 
de Steve Jobs de la scène Apple. 
L' iCEO, toute icône qu'il soit, n'est effecti-
vement pas éternel : il est naturel qu'il 
commence doucement à préparer sa suc-
cession, d'autant plus au moment où les 
projecteurs restent braqués sur ses ennuis 
de santé. En se basant sur les dernières 
keynotes, on peut sans risque affirmer que 
ce processus suit son cours ; Jobs est tou-
jours présent, mais se retire progressive-
ment au profit de ses «lieutenants», d'au-
tres figures proéminentes de la société tel-
les que Phil Schiller, Tim Cook, John Ive, 
Scott Forstall, etc. Un chef d'orchestre qui 
dévoile un peu plus son orchestre, en 
somme. Apple participera donc pour la 
dernière fois à la MacWorld, et sans Steve 
Jobs, ce qui a le mérite de faire passer un 
message : la société évolue sous tous les 
plans et se prépare au futur, quel qu'il soit. 
Une page a été tournée, mais sans grande 
surprise. Et nous ne pouvons qu'espérer 
que la page suivante se révèle aussi enri-
chissante que celle que nous admirons 
depuis des années.

-iMat
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Apple place chaque jour des produits reconditionnés, testés et approuvés sur le 
«Refurb Store». Les stocks se vident rapidement car il y a une grande affluence. Le site 
RefurbMe se charge de vous alerter pour chaque approvisionnement afin d!être parmi 
les premiers à bénéficier des remises. RefurbMe ne vend aucun produit, mais vous 
facilite leur achat sur le site d!Apple.

MacBook 2,1GHz Intel Core 2 Duo (Blanc)
Écran brillant de 13.3 pouces (1280 x 800)
1Go de mémoire
Disque dur de 120GB 5400-rpm
Lecteur Combo (DVD-ROM/CD-RW)

769"TTC

1049" (-28%)

MacBook Pro 2,4Ghz Intel Core 2 Duo
Écran panoramique brillant de 15 pouces 
2 Go de mémoire
Disque dur de 200 Go
Carte graphique NVIDIA GeForce 8600M GT avec 128Mo de mémoire GDDR3 
Lecteur SuperDrive 8x (DVD±R DL/DVD±RW/CD-RW)

1199"TTC

1999" (-38%)

iPod Touch (8Go)

169"TTC

280" (-40%)

169"TTC

259" (-35%)

iPod Classic (80Go)

99"TTC

209" (-53%)

iPod Nano (8Go)

Mac Pro Intel Xeon 4-Core à 2,8 GHz 
Deux processeurs Intel Xeon quadri-coeur à 3,0 GHz
2 Go de mémoire
Disque dur Serial ATA 320 Go (3 Gb/s) à 7 200 tr/min
SuperDrive 16x (DVD+R DL/DVD±RW/CD-RW)
Carte graphique NVIDIA GeForce 7300 GT avec 256 Mo de mémoire

2149"TTC

5444" (-60%)

MacBook Air Intel Core 2 Duo 1,6 GHz
Écran panoramique brillant de 13,3 pouces 
2 Go de mémoire
Disque dur PATA de 80 Go à 4 200 tr/min
Caméra iSight intégrée

1149"TTC

1699" (-40%)
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Partenaires
Chaque publication d'iPomme est une véritable aventure dans laquelle toute l'équipe investit beau-
coup de ses forces. Néanmoins, sans le concours de sites partenaires ou amis, cette entreprise serait 
encore plus éprouvante. C'est pour cette raison que la rédaction a le plaisir d'inaugurer cette page. 
Tous ceux qui, d'une façon ou d'une autre, apportent régulièrement leur pierre à l'édifice y sont ras-
semblés. Encore merci à eux !

AppleNews MQCD
AppleNews MQCD est le premier digg-like francophone autour du monde Apple. Il comporte éga-
lement un annuaire et un forum regroupant les passionnés du Mac. Ils nous soutiennent depuis le 
premier numéro et nous vous encourageons à les visiter. 

Mac-Gratuit
Mac-Gratuit est une mine d'or si vous êtes en quête de logiciels gratuits, ou freewares. Le site est di-
visé en plusieurs sections (Bureautique, développement, réseaux, multimédia, utilitaires, jeux, 
widgets, iPhone) : de quoi trouver la perle rare sans jamais risquer de devoir la payer. 

MacQuebec
MacQuebec est un site d'actualité incontournable pour tous les Québécois. Il constitue un bon relais 
des événements Mac des environs (et d'ailleurs !).

ActuJeunes
ActuJeunes est un site conçu par les jeunes pour les jeunes. Ces derniers rédigent des brèves d'ac-
tualité qui sont vérifiées, retouchées puis publiées. Le site est divisé en plusieurs rubriques pour une 
navigation plus claire et efficace. De plus, il comporte un forum pour débattre sur les news.

RefurbMe
RefurbMe se propose de vous aider à bondir sur les meilleures offres du Refurb Store. Ce dernier, 
rappelons-le, rend disponible à la vente des produits reconditionnés Apple, pour un prix plus bas qui 
ne sacrifie en rien la qualité. Un widget, des alarmes Growl et une newsletter sont disponibles en 
complément du site RefurbMe lui-même.

PersoLive
Le site PersoLive propose un système d'exploitation en ligne, accessible via n'importe quel naviga-
teur (et n'importe quel OS). Pour 32,90€ par an, vous obtenez 10 Go d'espace de stockage assortis 
d'un service très complet.

Un grand merci également à ceux qui nous diffusent tous les mois : LogicielMac et MacGeneration!

Source des news : MacGeneration et Mac4Ever.

http://applenews.mqcd.fr
http://applenews.mqcd.fr
http://mac-gratuit.fr
http://mac-gratuit.fr
http://www.macquebec.com/
http://www.macquebec.com/
http://actujeunes.fr
http://actujeunes.fr
http://refurb.me
http://refurb.me
http://persolive.com
http://persolive.com
http://logicielmac.com
http://logicielmac.com
http://macgeneration.com
http://macgeneration.com
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Milieu décembre, l’accord d’exclusivité entre Apple et Orange 
France a été rompu « à titre conservatoire » par le Conseil de la 
Concurrence. Cette décision permettra aux autres opérateurs 
téléphoniques de proposer l'iPhone. « Au moment où le déve-
loppement de l'Internet mobile et le lancement d'offres illimitées 
d'échange de données par les opérateurs pourraient animer le 
marché, l'exclusivité d'Orange sur l'iPhone est de nature à intro-
duire un nouveau facteur de rigidité ciblé sur ce segment du mar-
ché » a déclaré le conseil. 

Les contrats de 12 à 24 mois imposés sont également dénon-
cés pour leur longueur. Ce procédé de fidélisation ajoute un 
obstacle au changement d’opérateur. 

Plusieurs magasins ont sauté sur l'occasion pour se procurer 
l’iPhone. La FNAC par exemple, vend l’iPhone nu à un prix de 
800 € pour la version 8 Go et 900 € pour la version 16 Go. 
The Phone House vend également l’iPhone accompagné de 
toutes les offres de tous les opérateurs. 
Bouygues et SFR, de leur côté, travaillent d'arrache-pied pour 
proposer le téléphone pommé.

En bref...

De grands titres sur 
iPhone

Silent Hill, Metal Gear 
Solid et Dance Dance 
Revolution, rien que ce-
la !

Silent Hill est d'ores et 
déjà disponible sur 
l'App Store, mais son dé-
roulement linéaire et ses 
graphismes en deçà des 
capacités de l’iPhone 
ont déçu bon nombre 
de fans. Pour les deux 
autres titres, il faudra 
apparemment attendre 
le printemps 2009.

Ce mois-ci...

Actualités
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Un NetBook entièrement multitouch ? Un iMac QuadCore au 
design renouvelé et au système de refroidissement inédit ? Un 
nouveau Mac Mini ? Un iPhone Nano ? Telles sont les dernières 
rumeurs en date pour cette MacWorld 2009. 
Au vu des nouveaux MacBook introduits récemment, il ne se-
rait pas très logique de la part d’Apple de présenter un qua-
trième portable maintenant. L'iPhone Nano, quant à lui, sou-
lève les problèmes de la surface exploitable et des applica-
tions uniquement optimisées pour un écran 3.5 pouces. Ce-
pendant, plusieurs fabricants de protections ont créé le buzz 
en fournissant des éléments qui étaieraient cette rumeur. 
Rappelons qu'ils avaient visé dans le mille pour l'iPod Nano 
4G. La théorie d’un nouvel iMac est en revanche très plausible. 
Tout d’abord, cette machine n’a pas été mise à jour depuis avril 
2008, soit dix mois. Pour rappel, les ordinateurs Apple sont en 
moyenne renouvelés tous les huit ou neuf mois. 
En ce qui concerne les améliorations, l’adoption d’un proces-
seur QuadCore est plus que probable, étant donné qu’Intel est 
en train de les finaliser. Mais, si les iMac abandonnent leurs 
processeurs de portables, un nouveau système de refroidis-
sement risque de s'imposer ; il pousserait la consommation à 
65 watts, contre 55 pour la gamme actuelle. Ces iMac embar-
queraient également les nouveaux chipset NVidia (présents 
dans les derniers MacBook). Le Mac Mini, qui jusqu'ici faisait 
figure de mouton noir du troupeau Apple, bénéficiera peut-
être enfin d'une mise à jour. Cette machine, très appréciée des 
switchers et amateurs de media centers, commence en effet à 
devenir poussive (aucun graveur DVD sur le modèle d'entrée 
de gamme, fréquences de processeur dépassées...) 
Il revêtirait une robe d'aluminium pour l'occasion et pourrait 
contribuer à combler un vide dans les gammes Apple. 

En bref...

Multitouch & Firefox

La seconde beta (ver-
sion expérimentale) de 
Firefox 3.1 supporte en-
fin les gestures multi-
to u c h d e s d e r n i e r s 
trackpads. Pour person-
naliser ces commandes, 
i l f a u t t a p e r 
about:config dans la 
barre d’adresse, puis re-
chercher « gesture ». 

Il s'agit ensuite de trou-
ver la bonne syntaxe 
pour modifier les gestu-
res. Une configuration 
plus aisée devrait ac-
compagner la version 
finale de cette nouvelle 
mouture du butineur.

Ce mois-ci...

Actualités
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Très intéressant, ce brevet déposé par Apple le jour de Noël ! 
Il décrit une série de nouvelles gestures pour le clavier virtuel 
de l’iPhone et de l’iPod Touch. 

Par exemple, en glissant deux doigts vers le bas, un retour à la 
ligne serait effectué. Un glissement vers la gauche ferait passer 
le clavier du mode alphabétique au mode numéri- 
que, et le même glissement vers la droite déclencherait un ef-
facement. Voici une innovation qui pourrait faire gagner du 
temps aux utilisateurs.

A partir de là, les possibilités semblent infinies : changement 
de langage, implémentation du tant attendu copier/coller 
avec options de configuration...
Il ne reste plus qu'à attendre qu’Apple intègre cette nouveauté 
dans un prochain firmware de sa gamme mobile.

En bref...

Édition de fichiers 
Excel sur iPhone

Une fonction très atten-
due par les utilisateurs 
d'iPhone est enfin arri-
vée : l’édition de docu-
ments ! Pour l’instant, il 
n’est possible d’éditer 
que des documents Ex-
cel, via le logiciel Mobi-
leFiles Pro, pour la mo-
dique somme de 7,99 €. 
Ce n'est sans doute 
qu'un début, et les 
fichiers Word devraient 
tôt ou tard être concer-
n é s . C e l a r e n d r a i t 
l’iPhone plus attractif en 
entreprise.

Brevet

Actualités
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Au concours de l’emballage le plus rembourré, Apple a fait 
un score très honorable, comme en témoigne la photographie 
ci-dessous. La firme n'en était visiblement pas à son coup d'es-
sai : les initiés se souviennent encore de ce carton de la taille 
d’un MacBook utilisé pour emballer un simple adaptateur vi-
déo...

En bref...

Taux de satisfaction 
record pour Apple

98 % ! C’est le taux de 
satisfaction que décro-
che Apple chez l’Inter-
naute, sur 3459 répon-
s e s a u t o t a l . E n 
deuxième et troisième 
positions se trouvent 
Toshiba et Medion avec 
88% et 87%. 
En dessous se retrou-
vent respectivement 
Asus (86%), PC sur me-
sure (85%), Sony (83%), 
HP (80%), Dell (80%), 
Acer (77%), Fujitsu-Sie-
mens (69%) et finale-
m e n t , Pa c k a rd B e l l 
(68%). Dans la majorité 
des catégories, Apple 
l’emporte : puissance, 
logiciels, encombre-
ment, esthétique, si-
lence. Et, logiquement, 
Apple finit septième au 
niveau de la connecti-
que, qui laisse à désirer 
s u r l e s d e r n i e r s 
MacBook. 

Insolite !

Actualités

http://www.linternaute.com/hightech/micro/enquete/et-votre-marque-de-pc-preferee-est/enquete-de-satisfaction-achat-pc-2008.shtml
http://www.linternaute.com/hightech/micro/enquete/et-votre-marque-de-pc-preferee-est/enquete-de-satisfaction-achat-pc-2008.shtml
http://www.linternaute.com/hightech/micro/enquete/et-votre-marque-de-pc-preferee-est/enquete-de-satisfaction-achat-pc-2008.shtml
http://www.linternaute.com/hightech/micro/enquete/et-votre-marque-de-pc-preferee-est/enquete-de-satisfaction-achat-pc-2008.shtml
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31.01.2009
persolive.com

Soon.
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Achetez Mac moins cher

Théo
Treize

Rédac-
teur en chef
theo13@ipomme.info 

Dossier

De nos jours, qui ne cherche pas à dépen-
ser le moins possible ? Telle est l'optique 
de ce dossier : vous aider à dénicher les 
meilleures affaires sans risque de mau-
vaise surprise. Toutes les offres recensées 
sont en effet officielles et proviennent du 
site Apple.com.

1) Apple Refurb Store

L'Apple Store contient un rayon intitulé 
Refurb Store qui propose à la vente des 
produits défectueux renvoyés à Apple ou 
des fins de série. Ces produits subissent un 
processus de reconditionnement : ils sont 
remis à neuf, comprennent tous les élé-
ments d'origine (câbles, CD d'installation, 
manuels...) et sont soigneusement testés. 
Une garantie d'un an les accompagne, 
comme pour tout produit neuf. Si cette 
période vous semble trop courte, il reste 
possible de souscrire à un AppleCare lors 
de l'achat de la machine ou durant l'année 

qui suit. Veillez à bien acheter l'extension 
de garantie adaptée à votre machine ! 
Le Refurb est un choix judicieux : en fai-
sant preuve de patience, il est possible de 
trouver des produits bradés jusqu'à 40%.

mailto:theo@ipomme.info
mailto:theo@ipomme.info
http://www.apple.com/fr/
http://www.apple.com/fr/


iPomme Mag nº16 - 12 - Janvier 2009

Achetez Mac moins cher

Dossier

Il suffit de suivre ce lien pour visionner les 
articles disponibles. L'expédition des 
commandes est en général rapide, puis-
que les produits sont en stock.

Le dilemme réside dans la nature chan-
geante des offres du Refurb. Il va sans dire 
qu'il existe des moyens plus pratiques que 
la surveillance manuelle 24h/24h. Notre 
partenaire RefurbMe, entre autres, est là 
pour vous y aider. Le site est configurable 
et propose de nombreux modes d'alerte, 
dont un widget. Cette version du site, ra-
pidement accessible via Dashboard, est 
assortie d'alertes Growl et vocales person-
nalisables. Une newsletter et une déclinai-
son du site optimisée pour iPhone sont 
également de la partie.

Théo
Treize

Rédac-
teur en chef
theo13@ipomme.info 

http://store.apple.com/fr/browse/home/specialdeals/
http://store.apple.com/fr/browse/home/specialdeals/
http://refurb.me
http://refurb.me
mailto:theo@ipomme.info
mailto:theo@ipomme.info
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Théo
Treize

Rédac-
teur en chef
theo13@ipomme.info Achetez Mac moins cher

Dossier

2) Apple Store Éducation

Si vous avez au moins 18 ans et faites par-
tie d'une université (en tant qu'étudiant 
ou membre du corps enseignant), vous 
pouvez bénéficier de remises spéciales. 
Vous devez posséder une carte d'étudiant 
valide et employer les produits pour « vos 
besoins et utilisations personnelles et/ou 
à des fins d'enseignement ou de recher-
che». 

Le tarif de certains produits pouvant des-
cendre jusqu'à 200 €,  l'affaire n'est pas 
négligeable. Néanmoins, les iPod ne doi-
vent pas être considérés comme suffi-
samment centrés sur le travail universi-
taire : ils ne bénéficient d'aucune réduc-
tion. 

Pour quelques rares chanceux, il y a aussi 
le programme Apple On Campus, appella-
tion qui regroupe les universités partenai-
res d'Apple. Les étudiants concernés peu-
vent profiter de réductions allant jusqu'à 
16%, iPod exclus. Ce site répertorie les 
établissement concernés par l'opération.

mailto:theo@ipomme.info
mailto:theo@ipomme.info
http://store.apple.com/fr/browse/home/education_routing
http://store.apple.com/fr/browse/home/education_routing
http://store.apple.com/fr/browse/home/education_routing
http://store.apple.com/fr/browse/home/education_routing
http://www.apple.com/fr/aoc/
http://www.apple.com/fr/aoc/
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Théo
Treize

Rédac-
teur en chef
theo13@ipomme.info Achetez Mac moins cher

Dossier

3) Apple Financial Services

Ce service se destine aux particuliers dans 
une situation financière délicate, ou sim-
plement à qui désire étaler l'achat d'un 
Mac. Ici, nul besoin de passer par une 
banque. Apple propose un système de 
crédit avec paiement en plusieurs men-
sualités. L'offre la plus avantageuse pro-
pose un taux d'intérêt promotionnel de 
1,90 %, à partir de 700 €, et ce jusqu'au 17 
janvier 2009. Le paiement s'étend sur 12 
mois. 

Une offre fonctionnant à partir de 230 € 
est également proposée. Le paiement s'ef-
fectue sur une période de 10 mensualités 
mais à un taux d'intérêt assez fort de 
11,312 %.

Une offre à plus long terme est également 
disponible : jusqu'à 48 mensualités à partir 
de 230 € d'achat ! Mais le taux d'intérêt est 
évidemment élevé : 11,461 %.

4) Petits plus

Sachez également qu'il est possible de 
réaliser une économie de 90 € sur le prix 
d'une imprimante si vous l'achetez en 
même temps qu'un Mac sur l'Apple Store 
en ligne. Toujours sur l'Apple Store, en pé-
riode de rentrée scolaire, la promotion "Un 
Mac acheté, un iPod offert" fait son appari-
tion pour les étudiants. Un peu plus tard, 
vers fin novembre, c'est au tour du Black 
Friday ; cette année, les réductions étaient 
de l'ordre de 5% et touchaient la plupart 
des machines sur le Store.

Enfin, pour toutes les commandes de 
moins de 120 €, des frais de port de 7,90 € 
vous sont facturés. Vous pouvez par con-
séquent vous arranger avec des connais-
sances pour grouper les commandes et 
donc en être éxonéré. Il arrive néanmoins 
que les frais de ports soit exceptionnelle-
ment offerts sans minimum d'achat ; cette 
année, c'était le 1er décembre.

mailto:theo@ipomme.info
mailto:theo@ipomme.info
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Histoire Apple : 1976-1981

Dossier

À l'approche des 
33 ans d'Apple et 

des 25 ans du Mac, la 
rédaction a décidé de 
faire un point en 
plusieurs épisodes 
sur l'histoire de la 

firme à la pomme. Ces 
épisodes suivront sim-
plement la chronologie 

des événements. Le pre-
mier englobe la période 1976 - 1981, qui a 
vu l'apparition des premières machines 
estampillées Apple.

Plusieurs légendes courent à propos du 
nom Apple lui-même :
- Le jour où les deux Steve sont allés dépo-
ser le nom de l'entreprise, Wozniak man-
geait une pomme. Jobs aurait alors propo-
sé de prendre le nom Apple s'ils ne trou-
vaient pas mieux avant l'heure finale. Nous 
connaissons tous la suite.
- La pomme croquée en arc-en-ciel serait 
un hommage à Alain Turing, très grand 
mathématicien condamné à la castration 
chimique pour homosexualité. Il s'est sui-
cidé avant que la sentence ne soit exécu-
tée en croquant une pomme imbibée de 
cyanure.

Dans les années 50, les premiers ordina-
teurs occupaient 135 mètres carrés, pe-

saient 30 tonnes et fonctionnaient avec 
plus de 18000 tubes à vides (avant l'arri-
vée du transistor). Tout ceci pour remplir 
les fonctions d'une calculette classique 
d'aujourd'hui...
En 1948 apparaît le Mark 1, qui adopte le 
langage binaire : ce choix permet un fonc-
tionnement beaucoup plus simple, mais la 
machine occupe toujours beaucoup d'es-
pace.
La même année, l'une des plus grandes 
inventions du siècle est découverte : le 
transistor ! Composé de matériaux semi-
conducteurs, il remplit le rôle d'isolant ou 
de conducteur. Le gain de place et d'éner-
gie est énorme.
Cependant, il faut attendre encore 10 ans 
avant de voir le premier circuit imprimé 
sortir de chez Texas Instruments. Plusieurs 
transistors pouvant désormais cohabiter 
sur un même support électronique, la 
course à la miniaturisation est lancée.

Théo
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teur en chef
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Dossier

Suite à l'arrivée de ces mi-
croprocesseurs, il ne man-
que plus que les machines 
pour les exploiter. Les pre-
miers à se lancer dans 
l'aventure sont Steve Jobs, 
21 ans, et Steve Wozniak, 
26 ans. Ils travaillent à 
l'époque respectivement chez Atari et 
Hewlett-Packard. Wozniak s'est déjà lar-
gement penché sur la question : il détient 
des plans complets de son propre ordina-
teur avec les circuits de carte-mère, l'in-
terpréteur BASIC et Fortran pour cette 
dernière... sans avoir rien construit ! Le 
problème réside dans le prix des compo-
sants : le processeur 8080 d'Intel coûte 179 
$, seul. La perle rare est alors découverte : 
le 6502 de MOS Technology, vendu 25 $, 
et très semblable au 6800 de Motorola 
que Wozniak souhaitait utiliser dans ses 
machines. Les plans n'ont dû qu'être légè-
rement modifiés. 

Ronald Gerald Wayne était un compagnon 
de Jobs chez Atari. Il a joué le rôle d'arbitre 
dans les discussions des deux Steve et 
créé les documentations et le premier 
logo d'Apple : Newton sous son pom-
mier. Après avoir reçu 10 % du capital 
d'Apple, il décide de s'en séparer au 
bout de deux semaines pour 800 $.

Wozniak emploie quelques 
procédés nouveaux pour 
l'époque et qui sont pro-
pres à la première machine 
Apple. Il décide d'utiliser un 
gestionnaire clavier plutôt 
de des interrupteurs. La 
carte mère a été conçue 

pour utiliser un écran de télévision afin 
d'afficher les informations, plus que des 
diodes. De plus, la machine détecte auto-
matiquement le clavier pour mettre en 
place le système seul. En vendant plu-
sieurs objets personnels, Jobs et Wozniak 
ont pu fournir au magasin Byte 50 exem-
plaires de l'Apple I. Le prix de vente était 
de 666,66 dollars, composé du chiffre de la 
perfection (7) auquel on soustrait 1. Sur les 
200 machines produites au total, 175 se-
ront vendues en 10 mois. 
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Cependant, la ma-
chine était encore très 

loin de la perfec-
tion. Il fallait en-
trer 3000 carac-

tères à la main 
pour mettre en 

place l'intépré-
teur Basic, à 

chaque démar-
rage... Une solu-

tion fut instaurée : un adaptateur de lec-
teur de cassettes contenant le code. Mal-
heureusement, il fallait un magnétophone 
très cher pour que son signal soit assez 
clair  pour être reconnu par l'ordinateur. 

L'Apple I tel qu'on le connaît aujourd'hui 
est alors en cours de fabrication ; Byte est 
en pleine négociation avec un ébéniste 
pour créer un boîtier, tout en 
bois. Il sera présenté sous cette 
forme pour la première fois dans 
un grand salon électronique sur 
la côte Est. C'est ainsi qu'est 
connu le premier ordinateur 
d'Apple, accueilli par un grand 
succès pour l'époque.

Puis le projet Apple II est initié 
sous l'oeil Mike Markkula, qui 
prend la tête de la firme. Le 
premier sujet d'opposition ré-

side dans le nombre de baies d'extensions: 
Jobs considère que deux sont suffisantes, 
une pour le modem et une autre pour 
l'imprimante, mais Wozniak estime que les 
informaticiens trouveront bien une utilité 
à six baies supplémentaires. L'Apple II pos-
sède 4 Ko de RAM extensibles à 48 Ko, un 
affichage couleur et des programmes en-
registrés sur cassettes. 
Les composants restent le moins cher pos-
sible, ce qui se répercute sur le prix de 
vente, très correct : l'Apple II est accessible 
pour le consommateur moyen. C'est ce 
qui fait son succès : près de deux millions 
d'exemplaires trouvent preneur à travers 
le monde ! Au niveau des logiciels de l'Ap-
ple II, deux sont sortis du lot : VisiCalc, le 
premier tableur ; et AppleWriter, un logi-
ciel de traitement de texte, très puissant 
pour l'époque. 
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Sa première présentation publique a lieu 
en avril 1977, à la First West Coat Compu-
ter Fair. À cette occasion, Apple arbore un 
nouveau logo, celui de la pomme croquée 
aux bandes multicolores. Les programmes 
pour démontrer les capacités de l'Apple II 
furent créés à la dernière minute, mais 
rencontrèrent un franc succès. Les com-
mandes s'accumulèrent, alors que la 
presse avait tout simplement ignoré la 
présence d'Apple. 

Deux années plus tard, c'est au tour de 
l'Apple II+ de voir le jour. Celui-ci embar-
que 16, 32 ou 48 Ko de mémoire vive. Il 
rencontre également un franc succès, ac-
compagné par la première imprimante 
d'Apple : la Silentype. C'est le début de la 
fin des machines à écrire, alors que les 
machines Apple ne connais-
sent ni les minuscules, ni les 
accents. Il faudra attendre 
l'Apple III pour cela. 

Alors que l'Apple II com-
mençait à devenir faible 
face à la concurrence, Apple 
préparait déjà son rempla-
çant, sous le nom de code 
SARA. Il n'était en fait qu'un 
Apple II amélioré : RAM à 
126 Ko pouvant être dou-
blée, lecteur de disquettes 

intégré au boîtier, écran haute définition 
(80 caractères par ligne, contre la moitié 
pour l'Apple II), et la fameuse écriture en 
minuscule. Cette machine sera présentée 
en 1980 sous le nom d'Apple III. Le sys-
tème d'exploitation, SOS (Sophisticated 
Operating System) était bien plus perfor-
mant que son prédécesseur. Mais l'Apple 
III ne fut pas un grand succès à cause de 
nombreux défauts de fabrication. En effet, 
la conception interne de la machine était 
médiocre, les circuits électroniques de piè-
tre qualité, et tout ceci pour des raisons 
économiques. Apple sort donc une ver-
sion corrigée de l'Apple III, mais la réputa-
tion de mauvais ordinateur ne quittera 
jamais cette machine. Après avoir vendu 
65 000 unités, Apple décide de la retirer 
du marché.
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Tests

Très bonne initiative de la part d'Iris de 
proposer pour moins de 100 euros un sty-
lo scannant du texte. Le texte scanné s'in-
tègre ensuite dans toutes les applications 
possibles (traitement de texte, tableur, 
messagerie, carnet d'adresses, ...), le tout 
sur Mac OS et Windows. Lors du passage 
du crayon sur un texte (les images sont à 
proscrire, limitées aux signatures en noir 
et blanc), on aperçoit deux fenêtres : celle 
représentant ce que vient de "lire" le stylo 
et, en très léger différé, le résultat du scan 
effectué dans l'application voulue.

Installation, utilisation

En ouvrant la boîte, on trouve :
- Le stylo, plus long que large, que l'on 
tient bien en main malgré une apparente 
fragilité (dûe à sa coque en plasti-
que)
- Sur le corps du stylo, un double 
bouton programmable qui permet 
de choisir une action à effectuer sur 
le traitement de texte, sans utiliser 
clavier ni souris (retour à la ligne, ou 
tabulation, par exemple)
- Un câble USB de 1,70 m, longueur 
amplement suffisante pour scanner 
son texte sans être collé à son Mac
- Le CD d'installation (penser à bien 
installer le programme avant de 
brancher le stylo la première fois)

- Un manuel papier pour un démarrage 
rapide (le manuel complet pour Mac se 
t r o u v e à c e t t e a d r e s s e : 
ftp://ftp02.irislink.com/support/oa/opt/m
anuals/irispen6/frn/IP6-exp-mac-011007-
manual-frn.pdf )

Le test

Effectué sur un texte très connu :
"Déclaration universelle des droits de 
l'homme proclamée au Palais de Chaillot 
à Paris le 10 décembre 1948 par les 58 
Etats Membres qui constituaient alors 
l’Assemblée générale
Article 1. Tous les êtres humains naissent 
libres et égaux en dignité et en droits. Ils 
sont doués de raison et de conscience et 
doivent agir les uns envers les autres dans 
un esprit de fraternité."

Alain
Mangini

Rédacteur
alain.mangini@wanadoo.fr
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La première partie est en gras et les mots 
"Article 1." en italique. Il a été scanné dans 
différentes écritures au format 12 (Times 
New Roman, Arial, Comic sans ms, Lucida 
hanwriting et Brush Script standard) puis, 
au format classique "Times New Roman" à 
des tailles de 11, 10, 9, 8 et 7.

Résultats du test

Assez bon résultat pour le format 12 de 
Times New Roman :

« Déclaration universelle des droits de 
l'homme proclamée au Palais de Chaillot à 
Paris le 10 décembre 1948 par 'es 58 Etats 
Membres qui constituaient alors l'Assemblée 
générale, . l'
Article 1. Tous les êtres humains naissent li-
bres et égaux en dignité et en droits. Ils 
sont doués de: raison et de conscience 
et doivent agir les uns envers les au-
tres dans un esprit de fraternité. ,; »

Sous Arial et Comic, les résultats 
sont semblables.
Par contre, toutes les écritures qui 
s'approchent de l'écriture "script" 
sont à bannir, les résultats étant ca-
tastrophiques. Voici le résultat avec 
Lucida hanwriting et Brush Script 
standard (sans commentaire) :

« da-ktllh:ptÙI i ChaalotQ.,Pc.\rl.6-l,e,·lO 
1948 pa.r la-S8 M"uU' <," li:
rt"1. Têtve4fl.ibYe4feJ:et'\teJ: ,,,... et'\Id.f- 
l'Ut d,e,ye:td,e,.e:tdoWU\t ::. et'Werl-' 
GlM.tY CM'\I e4JPrit d.etfy. ;

"ni." ·;.........e,...,·,Ïte'. """lt...6h"t..t.'fJ sil" ,.. ,,,,, '- 
S, fUi ..t.u le..llle
1 ... 1 .." " IHv ( "::' .:,GU(::O:-:..·:::a_ ;.__ 4 »

La taille des caractères a également son 
importance. Jusqu'à la taille de 10 en Ti-
mes New Roman, l'essentiel des mots est 
conservé. Par contre, en dessous de 9, le 
texte n'est pas du tout compris par l'OCR 
(optical character recognition) ou recon-
naissance optique de caractères, malgré 
l'option cochée "Caractères de petite 
taille". 

Alain
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Rédacteur
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Voici le résultat pour la taille 9 :

« \'-,C ,- . !Membres qui constituaient alon 
l'Assemblie générale
;l:::=:;:;:? {!:;:.een dignité et en droi. lis 
sotou:s:":son et de co;':n: :d::t' ugir les uns 
envers les autres duos lin ..:spril J..: 
frall:IllII'" »

Remarques

Pour optimiser les résultats, il est préféra-
ble de travailler sous une lumière vive qui 
éclaire bien la zone scannée. Un test ra-
pide de calibrage sur feuille blanche est 
d'ailleurs recommandé pour chaque nou-
velle série de scans.

La vitesse du passage du stylo est égale-
ment un facteur de réussite (ou d'échec) à 

prendre en compte. Plus on va lentement, 
meilleur est le résultat !
La position du stylo est également très 
importante, légèrement penché vers la 
droite, mais pas trop.
Attention aux poils de chats sur le texte ou 
aux poussières sous la feuille.

Nous avons aimé

- Prise en compte des mots copiés lors des 
retours à la ligne
- Choix de plus de 120 langues
- Evite l'achat d'un scanner et d'un logiciel 
OCR comme Omnipage ou Irisreader
- Transportable avec son MacBook
- Rapidité de transcription dans le logiciel 
"cible"
- Possibilité d'utilisation comme gaucher

Nous aurions aimé

- Une meilleure reconnaissance de ca-
ractères (OCR). Dans l'état actuel des 
choses, il est nécessaire d'utiliser un 
logiciel de traitement de textes avec 
correction orthographique et gram-
maticale
- Pouvoir scanner un livre entier (au-
tre que ceux pour débutants)
- Que les signes de ponctuation s'invi-
tent moins facilement au milieu des 
phrases et à la fin des lignes.

Alain
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Evitez de scanner...
- Des images en couleurs ou de taille supé-
rieures à une signature
- Du texte écrit avec des polices non stan-
dard
- Des textes photocopiés (rien ne vaut 
l'original)
- Des textes abîmés ou avec des taches
- Des textes clairs sur fond noir même si 
cette possibilité a été prévue dans le logi-
ciel

On aimerait par la suite...
- Un stylo d'apparence plus solide avec 
une coque en aluminium
- Une connexion bluetooth pour éliminer 
le câble USB

- Un logiciel d'OCR plus performant, au 
moins en français

En un mot
Pour un achat de ce prix, on pouvait s'at-
tendre à mieux de la part d'Iris. Le résultat 
dépend de la qualité du texte à scanner 
avant tout. Si on lit attentivement le dos 
de la boîte, on trouve cet extrait : « L'Iris 
Pen scanne et reconnaît le texte avec une 
précision de 100%  » phrase interprétable 
dans plusieurs sens. Il ne faut pas com-
prendre qu'il est capable de reconnaître 
tous les caractères, mais plutôt que sa 
marge d'erreurs peut atteindre 100%.

Alain
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Rédacteur
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Envie de visionner certaines chaînes de 
télévision sans même quitter votre fau-
teuil ? LiveStation est peut-être fait pour 
vous. Ce programme propose un panora-
ma de chaînes assez faible, mais interna-
tional. On y retrouve deux chaînes franco-
phones : Euronews et France24. L'accès à 
de telles chaînes étant plutôt onéreux 
dans un pays étranger, cette solution 
pourrait se révéler utile pour les expatriés 
économes. Au niveau international, on re-
trouve entres autres : Al Jazeera, BBC, C-
SPAN, CNN, DW, Euronews, NASA TV, Rus-
sia Today (certaines de ces chaînes sont 
déclinées en plusieurs langues). 
Voilà de quoi se tenir au cou-
rant de l'actualité ! De plus, cer-
taines chaînes ne sont disponi-
bles que de temps à autre, 
comme celles répertoriées 
dans l'onglet "What's hot". Il 
suffit d'y jeter occasionnelle-
ment un oeil pour vérifier les 
retransmissions.
Sacré bémol néanmoins : vous 
ne pourrez rien enregistrer via 
ce logiciel. 

Impossible de ne pas se remé-
morer l'application Wizzgo (tes-
tée dans iPomme 11, juillet-
août 2008) qui jouait le rôle de 
magnétoscope numérique en 

proposant l'enregistrement des program-
mes français ; elle a récemment cessé 
toute activité suite à des actions en justice 
de groupes tels que TF1 et M6 (voir 
iPomme 15, décembre 2008, dans lequel 
nous vous invitions à signer la pétition). 
De quoi décourager ceux qui s'y essaie-
raient...
L'interface de LiveStation, très intuitive, 
n'est pas sans évoquer CoverFlow. Le prin-
cipal défaut  réside dans le faible nombre 
de chaînes disponibles, mais l'on ne peut 
qu'espérer que la liste s'allonge avec le 
temps.
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MPFreaker permet de compléter les don-
nées manquantes de vos chansons. Cela 
va de l'album jusqu'aux paroles en passant 
par l'année et le genre ! Cependant, le lo-
giciel nécessite un minimum d'informa-
tions pour retrouver les pièces manquan-
tes. Si, par exemple, votre morceau est dé-
pourvu de titre ou d'artiste, MPFreaker ne 
sera pas en mesure de vous aider.
Le fonctionnement de MPFreaker est sim-
ple : au démarrage, votre bibliothèque 
iTunes est analysée. La première fois, le 
processus prend un certain temps, d'au-
tant plus si votre bibliothèque est bien 

fournie. Par la suite, seuls les nouveaux 
morceaux sont indexés au démarrage du 
logiciel, ce qui l'accélère grandement.
Une fois cette formalité achevée, vous êtes 
libre de sélectionner les morceaux incom-
plets ( / cmd + a pour tout sélectionner) 
et cliquer sur «commencer la complétion». 
iPomme a testé l'efficacité de MPFreaker 
sur une chanson sélectionnée au hasard. 
Celle-ci a été dépossédée de toutes ses 
métadonnées, hormis le titre de la chan-
son et l'artiste ; le logiciel a réussi à glaner 
plus de renseignements qu'avant l'opéra-
tion !

Pour ne rien gâcher, quelques 
fonctionnalités appréciables 
sont de la partie : actualiser 
automatiquement iTunes (par 
défaut), ignorer les illustra-
tions non carrées, définir des 
tailles maximum et minimum 
pour les jaquettes, etc.
Ce logiciel devrait donc satis-
faire tous les mélomanes, ex-
ceptés les adeptes des artistes 
libres (bien souvent trop peu 
connus), pour un prix relati-
v e m e n t é l e v é d e 2 0 $ . 
MPFreaker est disponible au 
téléchargement à  à cette 
adresse.
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Initiation au Terminal II

Pratique

Dans le numéro de décembre, nous avons 
commencé à gratter la surface du Terminal 
et des richesses qu'il recèle. En outre, nous 
avons étudié quelques commandes basi-
ques permettant une interaction avec les 
fichiers contenus sur le disque et quelques 
utilitaires indispensables comme le ma-
nuel. Alors, avant de s'attaquer au sujet 
plus pointu des autorisations, pourquoi ne 
pas approfondir celui que nous avons en-
tamé?

Manipulation des fichiers : on conti-
nue...

Maintenant que nous savons lister des fi-
chiers et naviguer dans l'arborescence, au-
tant en profiter pour effectuer des tâches 
un peu plus enrichissantes et plus utiles. 
Ce chapitre sera donc presque exclusive-
ment consacré à la suppression, la copie 
ou au déplacement de fichiers via la ligne 
de commande. Pour plus de clarté, la syn-
taxe des commandes prendra désormais 
exemple sur celle du manuel. Si cela vous 
semble ésotérique, nous ne saurions que 
vous inviter à relire la première partie de 
ce tutoriel.

1) cp (copy)

Comme son nom l'indique, cette com-
mande vous permet de copier des fichiers.

Deux syntaxes de cp sont possibles :

cp [-R [-H | -L | -P]] [-f | -i | -n] [-pv] fi-
chier_source fichier_cible
cp [-R [-H | -L | -P]] [-f | -i | -n] [-pv] fi-
chier_source ... dossier_cible

La barre verticale «|» que nous n'avons pas 
encore abordé a la valeur du «ou», c'est-à-
dire qu'il vous faut choisir une seule op-
tion parmi celles proposées. Tenter d'en 
utiliser plusieurs à la fois ne ferait que neu-
traliser leurs effets.

Si l'utilisateur choisit la première syntaxe, il 
doit spécifier un seul fichier à copier 
(grâce à un chemin absolu ou relatif ), lui 
assigner un nom (le même ou pas) et un 
nouveau chemin (là encore, relatif ou ab-
solu).

ex: cp /Users/VotreNom/Pictures/"Photo 
Booth"/Dingo.jpg 
/Users/VotreNom/Desktop/Anthologie/
Donald.jpg

Ici, nous avons simplement sélectionné 
une photographie dans le dossier Photo 
Booth, l'avons copiée dans un dossier du 
bureau et renommée pour l'occasion (de 
Dingo.jpg à Donald.jpg). Le tout en utili-
sant des chemins absolus.

iMat

Rédacteur en chef adjoint
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A noter que la photo originelle n'a pas 
disparu : il s'agit d'une copie, non d'un dé-
placement. (nous étudierons plus tard une 
commande qui le permet). La deuxième 
syntaxe consiste à désigner plusieurs fi-
chiers et un dossier d'arrivée. Par exemple, 
supposons que nous partions du dossier 
Photo Booth...

ex: cp "Premier de l'an.jpg" "Theo13 
ivre.jpg" "Vieux Gaucho.jpg" /Users/Vo-
treNom/Desktop/Anthologie

Cette fois, nous avons copié trois photos 
au format .jpg vers le dossier "Anthologie" 
du bureau. Puisque le répertoire actif était 
"Photo Booth", nous avons d'abord utilisé 
un chemin relatif, puis un chemin absolu 
pour désigner le dossier cible.

Bien sûr, comme pour chaque commande, 
il est possible d'étendre les possibilités de 
cp avec des options. Dressons donc une 
brève liste des plus utiles.

Option R (cp -R) : A utiliser si vous souhai-
tez copier un répertoire plutôt qu'un fi-
chier. Ainsi, toute son arborescence (et 
donc les fichiers qu'il contient) est copiée. 
A noter que les effets des deux syntaxes 
ne changent pas (vous pouvez copier plu-
sieurs répertoires, ou n'en copier qu'un 
seul et lui attribuer un nouveau nom, etc).

Option v (cp -v) : Cette option active le 
mode verbeux, c'est à dire que le terminal 
affiche la liste des copies effectuées et leur 
nouvel emplacement. Bien utile si vous re-
cherchez un maximum de transparence.

Option f (cp -f) : Les fichiers écrasent les 
anciens fichiers du même nom sans 
qu'aucune confirmation ne vous soit de-
mandée. Le Terminal semble se comporter 
de cette façon par défaut.

Option n (cp -n) : Au contraire, aucun fi-
chier existant n'est écrasé.

Option i (cp -i) : Un compromis avanta-
geux, puisque le Terminal vous demande 
confirmation avant d'écraser un fichier ou 
non.

Option p (cp -p) : Cette option préserve 
autant de méta-données (dates de modifi-
cation et d'accès, ID de l'utilisateur et du 
groupe, etc) à propos du / des fichier(s) 
copié(s) que possible.

Inutile de rappeler que ces options sont 
cumulables entre elles. Mais, comme nous 
l'avons vu, en mélanger certaines peut très 
bien ne produire aucun effet, ou bien 
donner l'avantage à une option sur une 
autre. Pas d'inquiétude, le manuel est tou-
jours là pour le préciser !
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2) mv (move)

Cette commande permet de déplacer des 
fichiers au lieu de les copier. Si vous maî-
trisez la commande cp, vous ne devriez 
avoir aucun mal à domestiquer celle-ci, de 
par ses syntaxes identiques.

Voici en effet ce qu'en dit le manuel (pour 
l'accessibilité de ce tutoriel, les mots an-
glais seront traduits, mais il va de soit que 
la documentation officielle est plus four-
nie qu'un numéro d'iPomme) :

mv [-f | -i | -n] [-v] source cible
mv [-f | -i | -n] [-v] source ... répertoire

Il n'y a pas grand chose à ajouter, tout (ou 
presque) ayant été dit dans le chapitre 
précédent. La seule différence de fonc-
tionnement réside dans le fait que quand 
vous copiez un fichier, son ancien chemin 
est détruit. En clair, il n'existe plus qu'en 
un seul exemplaire, sur le nouveau chemin 
que vous avez spécifié.
Enfin, rien ne vous empêche de déplacer 
des répertoires, sans même avoir besoin 
de spécifier d'option ! Leur arborescence 
sera déplacée sans aucun problème.

Du côté des options, vous n'aurez guère 
que f, i, n et v que nous avons vu plus tôt 
et dont vous connaissez désormais le rôle.

3) mkdir (make directory)

Maintenant que vous savez déplacer ou 
copier des fichiers, peut-être voudrez vous 
les ranger dans de nouveaux répertoires. 
Aucun problème, le Terminal peut aussi en 
créer au besoin.

La syntaxe est la suivante :

mkdir [-pv] [-m mode] directory_name ...

Le fonctionnement de mkdir ne devrait 
pas vous désorienter : il suffit d'utiliser la 
commande suivie d'un chemin, agrémen-
tée d'éventuelles options. Si vous souhai-
tez créer un nouveau répertoire dans vo-
tre dossier courant, il suffit d'entrer son 
nom comme paramètre.

ex : mkdir /Users/VotreNom/Desktop/i-
Pomme

Ici, nous avons créé un dossier iPomme sur 
le bureau grâce à un chemin absolu. Mais, 
et à condition que le bureau soit le dossier 
courant, il est aussi possible d'entrer 
mkdir iPomme pour aboutir au même ré-
sultat.
Aujourd'hui, nous ne nous attarderons pas 
sur l'option m qui peut se révéler très inté-
ressante mais qui concerne les fameuses 
autorisations.
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Quant à l'option v (verbose), vous la con-
naissez normalement très bien.En revan-
che, l'option p peut nous servir tout de 
suite : elle permet de créer des répertoires 
intermédiaires (et donc une arbores-
cence). Tentons donc de remplir le dossier 
iPomme que nous venons de créer (en 
partant du principe que le bureau est no-
tre dossier courant).

ex : mkdir -p iPomme/n15/test iPomme/
n16

Il est important de bien saisir l'effet de 
cette commande. Ses paramètres sont di-
visés en deux parties : la première (iPom-
me/n15/test) crée un dossier «n15» con-
tenant un dossier «test» et la seconde crée 
un dossier «n16» au même niveau de l'ar-
borescence que le dossier «n15». Bien en-
tendu, rien ne vous oblige à créer votre 
arborescence en une seule commande (il 
est possible d'entrer mkdir -p iPomme/
n15/test puis mkdir -p iPomme/n16 mais 
avouez que c'est moins rapide). Il va de 
soit que vous pouvez ajouter autant de 
paramètres que vous le souhaitez.

4)rm (remove)

Attention, nous attaquons les commandes 
potentiellement dangereuses, alors pre-
nez garde à ce que vous écrivez ! 

rm permet à l'utilisateur de supprimer 
n'importe quel fichier sur le disque dur. 
Avec la bonne commande, il est même ai-
sé de tout effacer à partir de la racine (ce 
qui signifie, vous l'avez compris, tout le 
contenu de votre disque). Les témoigna-
ges d'accidents bêtes dus à cette com-
mande sont déjà trop nombreux sur la 
toile, et nous serions bien gênés d'en dé-
couvrir parmi nos lecteurs ! Bien entendu, 
iPomme ne saurait être tenu responsable 
de la destruction de disques, vies, familles, 
etc.
Il était préférable de trop insister sur les 
avertissements que pas assez ; néanmoins, 
si vous êtes attentifs et raisonnables, il n'y 
a aucune raison que quoi que ce soit se 
déroule mal.

Ces formalités achevées, attaquons nous 
au coeur du sujet !

La commande rm fonctionne ainsi :

rm [-dfiPRrvW] file ...

Rien de bien compliqué ici, il suffit de spé-
cifier un fichier ou un chemin à la suite de 
la commande. Réfléchissez bien avant de 
l'utiliser, car le fichier ne passe pas par la 
case corbeille et la fonction annuler 
n'existe pas !
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Du côté des options, on retrouve :

Option d (rm -d) : A utiliser pour suppri-
mer un répertoire vide. Il est également 
possible d'employer la commande rmdir 
(remove directory).

Option R/r (rm -r ou rm -R) : Permet de 
supprimer récursivement une arbores-
cence. C'est l'option à employer si vous 
désirez supprimer un répertoire qui con-
tient d'autres fichiers (l'option d est impli-
quée). Utilisez cette option en partant de 
la racine, et c'est votre volume que vous 
effacez.

Option f (rm -f) : Empêche la création de 
messages d'erreur, quels que soient les fi-
chiers supprimés.

Option i (rm -i) : Nous l'avons déjà abor-
dée. Cette option produit l'inverse de l'op-
tion f en vous demandant confirmation 
avant toute suppression. Répondez «y» 
(yes) pour oui et «n» (no) pour non.

Option P (rm -P) : Utilise un effacement 
sécurisé (le fichier est écrasé plusieurs 
fois).

Option v (rm -v) : Comme toujours, à uti-
liser pour plus de clarté.

ex : rm -r /Users/VotreNom/Desktop/i-
Pomme

Et c'est le travail de plusieurs mois qui 
s'envole !

Voilà que nous avons un peu défriché le 
terrain de la manipulation des fichiers via 
le Terminal sous OS X. Mais comme nous 
culpabiliserions de vous abandonner sans 
un dernier cadeau pour les fêtes, voici une 
section qui pourra vous intéresser...

5) open

La commande open est spécifique à Mac 
OS X. Comme son nom l'indique, elle per-
met l'ouverture de fichiers via notre cher 
Terminal.

Résumons sa syntaxe :

open [-e] [-t] [-f] [-W] [-n] [-g] [-h] [-a ap-
plication] fichier ...

Comme souvent, il suffit d'utiliser la com-
mande, une éventuelle option et le nom 
du ou des fichiers comme paramètre.

En ce qui concerne les options :

Option a (open -a application) : Spécifie 
une application pour ouvrir le document.
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Si vous n'en spécifiez aucune, c'est l'appli-
cation par défaut qui sera utilisée.

ex : open -a "QuickTime Player" 
"Soudard.mp3"

Option e (open -e) : Le fichier est ouvert 
avec TextEdit.

Option g (open -g) : L'application ouverte 
ne s'invite pas au premier plan.

Enfin, sachez qu'il est possible d'ouvrir des 
URL de cette façon.

A suivre...(2)

Voilà, la deuxième partie de ce tutoriel 
s'achève déjà. Vous avez de nouveau un 
certain nombre d'informations à digérer, 
et quoi de mieux pour cela que de vous 
entraîner ? Toutes les options n'ont pas été 
détaillées, et le manuel vous tend les bras.
Dans la troisième partie, nous étudierons 
la question des autorisations, ce qui ap-
portera une toute nouvelle dimension à 
nos commandes adorées.
En espérant que vous ne vous êtes pas 
perdus en route, iPomme vous souhaite 
un bon voyage sur les voies sinueuses du 
Terminal !
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Le logiciel «Dictionnaire» d'Apple est très 
intéressant pour les anglophones, mais in-
accessible aux autres. En effet, il ne con-
centre que les dictionnaires Oxford, The-
saurus, Apple et Wikipedia. Cette encyclo-
pédie bien connue étant multilingue, elle 
l'est également via le logiciel d'Apple, mais 
se révèle insuffisante dans la plupart des 
cas.

Ce tutoriel entreprendra donc de vous 
guider à travers les étapes de l'installation 
de dictionnaires supplémentaires. De 
cette façon, vous pourrez personnaliser le 
Dictionnaire en fonction de vos besoins et 
en faire un hub linguistique puissant et 
accessible (via Spotlight, notamment). 

Tout d'abord, vous devez télécharger les 
dictionnaires qui vous intéressent  sur 
cette page. Il vaut mieux veiller à ce que 
les noms des archives soient en adéqua-
tion avec les dictionnaires qu'elles con-
tiennent, cela sera utile par la suite. 

Ensuite, procurez-vous l'application Dic-
tUnifier et lancez-le. Copiez le nom d'une 
archive que vous avez téléchargée et at-
tribuez-lui un nouveau nom court (comme 
«aaa»). Il vaut mieux prendre cette précau-
tion, car DictUnifier est visiblement aller-
gique aux noms longs...
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Sélectionnez l'archive renommée, puis 
dans "Dictionary Name" et "Dictionary ID", 
collez le nom que vous avez copié. Pour 
finir, cliquez sur Convert pour lancer la 
conversion. Voilà, l'application Diction-
naire dispose d'une ressource supplémen-
taire ! 

Cependant, si vous aviez nommé votre 
dictionnaire "Oxford Advanced Learner’s 
Dictionary", il est possible qu'il n'appa-
raisse qu'en tant que "Oxford". Une petite 
manipulation est nécessaire pour y remé-
dier. Quittez donc Dictionnaire et DictUni-

fier. Rendez-vous dans le dossier Maison 
-> Bibliothèque -> Dictionaries. Cher-
chez le dictionnaire que vous venez de 
convertir, puis attribuez-lui le nom le plus 
éloquent possible, ou cas où vous auriez à 
le modifier une autre fois. 

Allez ensuite dans Contents et ouvrez le 
fichier Info.plist. Il ne vous reste plus qu'à 
modifier CFBundleName et CFBundle-
DisplayName avec le nom que vous dési-
rez. Il suffit de sauvegarder le fichier pour 
que les modifications de nom deviennent 
effectives !
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Le programme d'exemple

Afin d'être plus concrètes, les explications 
s'articuleront autour d'un programme 
simple, pas très éloigné de l'exemple clas-
sique d'Apple, à savoir, le convertisseur de 
monnaie. Cependant, je m'adresse ici à 
des programmeurs chevronnés qui vou-
dront rapidement en venir aux faits.

Le principe de notre programme est le 
suivant: une fenêtre comprend deux 
champs éditables. Taper une température 
dans le champ Degrés Fahreinheit et vali-

der fait apparaître la conversion dans le 
champ Degrés Celcius et vice-versa.

Le paradigme M-V-C

À l'instar d'autres bibliothèques de déve-
loppement, Cocoa est basée sur le para-
digme Modèle-Vue-Contrôleur, qui sépare 
les Vues (l'interface utilisateur) du Modèle 
(la partie qui conserve les données et ef-
fectue les calculs). Le Contrôleur fait les 
liens entre les deux couches. 
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Création du projet

XCode impose la création d'un projet pour 
regrouper les différents fichiers consti-
tuant l'application et définir ses paramè-
tres de construction.

Sous XCode, sélectionnez le menu File > 
New Project… > Application > Cocoa 
Application. Cliquez sur Next, tapez un 
nom pour le projet, et choisissez sa locali-
sation. La fenêtre du nouveau projet s'ou-
vre; il y a déjà quelques fichiers dans le 
projet.

Programme principal

Jetez un œil à main.m, dans la rubrique 
Other Sources:

    #import <Cocoa/Cocoa.h>

    int main(int argc, char *argv[])
    {
        return NSApplicationMain(argc,  
(const char **) argv);
    }

Nous reconnaissons la forme canonique 
utilisée en C pour la fonction main(). Elle 

ne fait qu'appeler NSApplicationMain() qui 
va essentiellement créer une instance de 
la classe NSApplication.

La directive de compilation #import est 
similaire à #include, si ce n'est qu'un fi-
chier déjà inclus ne le sera pas une se-
conde fois. On inclut ici cocoa.h qui se 
trouve dans le framework Cocoa. 

 Ressources

Dans la rubrique Resources , vous trouve-
rez trois fichiers:

- Info.plist Comme vous le voyez, il s'agit 
d'un fichier XML. Vous pouvez d'ailleurs 
éditer les fichiers .plist grâce à l'utilitaire 
Property List Editor, mais ce fichier-là peut 
être édité d'une façon plus conviviale (…
c'est vite dit) dans XCode (menu Project > 
Edit Active Target).
 
- InfoPlist.strings Les fichiers .strings ser-
vent à traduire une application dans une 
autre langue — ce qu'on dénomme sou-
vent par le vilain anglicisme localiser. Les 
clefs y sont associées aux texte traduits. Ce 
fichier-ci est utilisé pour le texte s'affichant 
dans la boîte de dialogue À propos de…
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- MainMenu.nib Ce fichier contient des 
éléments d'interface utilisateur. Double-
cliquez-le pour l'ouvrir dans Interface 
Builder… il y a déjà du monde à l'intérieur.

Couche Vue

Faîtes en sorte que la fenêtre Window res-
semble à ceci:

Vous trouverez les éléments dans la pa-
lette Library (menu Tools > Library), dans 
la rubrique Cocoa > Views & Cells. Les 
champs éditables sont des Text Fields. Les 
intitulés sont des Label.

Couche Modèle

Nous allons ici créer la classe CFRConver-
tisseur. Pourquoi pas Convertisseur tout 
court ? Traditionnellement, les noms de 
classes commencent par un suffixe pour 
éviter des conflits (il n'existe qu'un na-
mespace par application). Les classes de 

Cocoa commencent par NS pour… Next 
Step. 

Sous XCode, dans la fenêtre du projet, sé-
lectionnez la rubrique Classes. Sélection-
nez le menu File > New File… > Cocoa > 
Objective-C Class. Cliquez sur Next, vous 
serez alors invités à saisir le nom. Tapez 
donc CFRConvertisseur.m. Puis cliquez sur 
Finish. Deux fichiers, CFRConvertisseur.m et 
CFRConvertisseur.h, sont alors insérés dans 
le projet. Ouvrez donc le .h :

    #import <Cocoa/Cocoa.h>

    @interface CFRConvertisseur : NSOb-
ject {

    }

    @end

C'est ainsi que l'on déclare une classe en 
Objective-C. NSObject est l'objet de base, 
dont héritent tous les objets, à de rares 
exceptions près.

On place entre les accolades les défini-
tions des variables d'instances (variables 
membres). Notre programme n'en néces-
sitant pas, nous les laissons vides. Nous 
définissons, entre l'accolade } et @end, les 
méthodes. 
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Comme nos méthodes n'accèdent pas aux 
variables d'instance, nous les déclarons 
comme des méthodes de classes (ce qu'on 
appellerait des méthodes "statiques" en 
Java), en les précédant du signe + .

+ (float) 
convertirCelciusEnFahrenheit:(float)cel
cius;
+ (float) 
convertirFahrenheitEnCelcius:(float)fah
renheit;

Pour information : les méthodes d'instan-
ces sont précédées du signe - .

Copiez ces deux lignes et ouvrez 
CFRConvertisseur.m.

Pour ouvrir le .m correspondant au .h cou-
rant, et vice-versa, cliquez sur la petite 
icône counterpart (en haut à droite) ou 
bien utilisez le menu View > Switch   
to Header / Source File.

Collez les prototypes des méthodes, afin 
d'implémenter les formules de conversion:

    #import "CFRConvertisseur.h"

    @implementation CFRConvertisseur
    + (float) 
convertirCelciusEnFahrenheit:(float)cel
cius
    {
        return (9.0/5.0) * celcius + 32.0;
    }
    + (float) 
convertirFahrenheitEnCelcius:(float)fah
renheit
    {
        return (5.0/9.0) * (fahrenheit - 32.0);
    }

    @end

Couche contrôleur

Et maintenant, nous programmons la cou-
che contrôleur, qui fait le lien entre les 
vues et le modèle. Créez un nouveau fi-
chier source, appelé CFRControleur.m. 

Déclarations des outlets

    @interface CFRControleur : NSObject {
        IBOutlet NSTextField*   
champFahrenheit;
        IBOutlet NSTextField*   champCel-
cius;    }
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Les outlets sont des variables d'instance, 
quand notre classe CFRControlleur sera 
instanciée (à la lecture du fichier .nib), Co-
coa fera pointer les variables sur les objets 
que nous leur auront lié. Nous allons voir 
ces liaisons dans un instant. Ecrire IBOutlet 
est nécessaire pour qu'Interface Builder 
sache qu'il s'agit d'outlets.

N'oubliez pas de rajouter #import 
"CFRConvertisseur.h"

Déclaration des actions

    @interface CFRControleur : NSObject {
        IBOutlet NSTextField*   
champFahrenheit;
        IBOutlet NSTextField*   champCel-
cius;
    }

    - ( I B A c t i o n ) 
fahrenheitModifie:(id)sender;
    - (IBAction) celciusModifie:(id)sender;

    @end

Les actions sont des méthodes qui sont 
appelées lorsqu'un contrôle est actionné. 
Pour nos champs, cela signifie qu'on aura 
validé leur contenu en tapant sur Entrée. 
Une action a forcément un prototype de 
cette forme. id est le type générique des 

objets. Nous savons évidemment qu'il 
s'agit de NSTextFields.
Regardez donc à quoi correspond le sym-
bole IBAction…

Sous XCode, pour accéder à la définition 
d'un symbole, maintenez la touche Com-
mande appuyée, et double-cliquez le 
symbole.

On peut voir qu'IBAction est équivalent à 
void et qu'IBOutlet équivaut à rien. 

Liaison des Outlets et Actions

Retournez sous Interface Builder. Faîtes 
apparaître la palette Library (menu Tools > 
Library). Dans la rubrique Library > Cocoa 
> Objects & Controllers, vous trouverez un 
cube bleu, intitulé NSObject. Glissez-le 
dans la fenêtre MainMenu.nib. Ainsi, Co-
coa instanciera un objet de la classe 
NSObject à l'ouverture du .nib… mais ce 
n'est pas ce que nous voulons ! Sélection-
nez le cube, puis dans la palette Inspector 
> Object Identity mettez le champ Class à 
CFRControleur. Vous remarquerez que les 
actions et outlets sont apparues au bas. 

Cliquez sur le cube bleu en maintenant la 
touche Contrôle appuyée (ou bien clic 
droit), et reliez le cube au champ Fahren-
heit. 
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Quand vous lâchez le bouton, un menu 
apparaît: choisissez champFahrenheit. Et 
voilà! L'outlet, champFahrenheit est liée au 
champ la représentant. Faîtes de même 
pour le champ Celcius.

Pour les actions, c'est pareil, mais en tirant 
un segment du champ vers le cube. Je 
vous laisse faire.
Implémentation des actions

Revenons à XCode et à CFRControleur.m, 
pour y ajouter les deux méthodes d'ac-
tions:

    - (IBAction) 
fahrenheitModifie:(id)sender
    {
        // Afficher la température convertie 
dans le champ Celcius
        float fahrenheit = [sender floatVa-
lue];
        float celcius = [CFRConvertisseur 
convertirFahrenheitEnCelcius:fahrenhe
it];
        [champCelcius 
setFloatValue:celcius];
    }

Remarquez le [sender floatValue]. Il s'agit 
d'un appel de méthode, qu'on appelle 
plus volontiers un message en ObjC. Nous 
savons que sender est notre NSTextField 

Fahrenheit. Nous lui demandons de nous 
envoyer sa valeur sous la forme d'un float. 

[CFRConvertisseur 
convertirFahrenheitEnCelcius:fahrenheit] 
est également un message, mais comme 
convertirFahrenheitEnCelcius: est une mé-
thode de classe, nous la faisons précéder 
du nom de sa classe.

Finalement, nous demandons au champ 
Celcius d'afficher la valeur celcius.

Ajoutons l'autre méthode:

    - (IBAction) celciusModifie:(id)sender
    {
        // Afficher la température convertie 
dans le champ Fahrenheit
        [champFahrenheit 
setFloatValue:[CFRConvertisseur 
convertirCelciusEnFahrenheit:[sender 
floatValue]]];
    }

Cette méthode est similaire à la préce-
dente, si ce n'est que j'ai imbriqué les mes-
sages.

Terminez par ajouter :

    #import "CFRConvertisseur.h"
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Pratique

Alors ça marche ?

Nous n'avons plus qu'à lancer le pro-
gramme: menu Run > Run. Ça doit compi-
ler et lancer l'application. Je vous laisse 
jouer et essayer quelques valeurs.
Quelques améliorations

Vous aurez peut-être remarqué que le 
programme souffre de deux défauts:

- trop de chiffres sont affichés (c'est ines-
thétique)

- si on entre des caractères plu-
tôt que des chiffres, cela revient 
à taper zéro (c'est mal).

Retournez sous Interface Buil-
der. Dans la palette Library > 
Library > Cocoa > Views & Cell, 
recherchez le Number Formater 
(un rectangle avec un $ ). Glis-
sez-le sur le champ Fahrenheit. 
Allez dans la première rubrique 
de l'Inspecteur (Number Forma-
ter Attributes), et mettez-y le 
menu Style à Decimal. Faîtes de 
même pour le champ Celcius.

Retournez sous XCode, relancez 
l'application… les deux défauts 
sont réglés !

Pour finir

Cet article n'était qu'une introduction, 
mais vous a cependant présenté les con-
cepts de bases de Cocoa: MVC, édition des 
.nib, Outlets et actions. Les prochains arti-
cles vous aideront à approfondir ces con-
naissances.

Le projet complet à télécharger, si vous 
n'avez pas réussi. 
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